
Training 

Create formulas in Excel 

EXERCISE 1: TYPE SOME SIMPLE FORMULAS TO ADD, SUBTRACT, MULTIPLY, AND 

DIVIDE 

1. Click in cell A1. First you’ll add two numbers. 

2. Type =534+382. 

3. Press ENTER on your keyboard to get the result of 916. 

4. Now let’s subtract, multiply, and divide: 

 In cell A2, type =534-382 and press ENTER. Result: 152. 

 In cell A3, type =534*382 and press ENTER. Result: 203988. 

 In cell A4, type =534/382 and press ENTER. Result: 1.397906. (The answer may vary, depending on how 

many decimal places are set up in your version of Excel.) 

5. Click in cell A4 to adjust the number of numerals after the decimal place. Make sure you are on the Home tab. 

If not, click the tab to select it. 

6. Move the pointer up to the ribbon, where it says Number (called the Number group) . 

7. In the Number group, point to Decrease Decimal and click. Notice the result in cell A4, which should have 

one less number after the decimal point. Click Decrease Decimal as many times you want to adjust the 

number. 

EXERCISE 2: USE MULTIPLE MATH OPERATORS IN THE SAME FORMULA 

 Write a formula for Excel to calculate 4+4, and then multiply the result by 6. 

Hint Remember the rules of operator precedence: Things inside parentheses (or brackets) are calculated first, 

and multiplication comes before addition. 

 There are two ways you could write it: =(4+4)*6. Result: 48. Or you could write it this way to get the same result: 

=6*(4+4). 

Although multiplication comes before addition, whatever is in brackets is calculated first.  



EXERCISE 3: ADD NUMBERS BY USING THE SUM FUNCTION 

1. Click in cell A5. 

2. On the Home tab, move the pointer to where it says Editing (called the Editing group) . 

3. Click AutoSum .The formula appears on the spreadsheet. It should include all the cells between cell A1 

and cell A4. 

4. Press ENTER to get the result: 205057.4. 

The result may vary, depending on how many decimal places are set up in your version of Excel. 

EXERCISE 4: USE THE SUM FUNCTION TO ADD 2 NUMBERS IN A COLUMN 

1. Click in any blank cell. Cell C2, for example. Type =SUM(. 

2. Click in cell A1 to enter the cell into the formula. Type a comma (,) after A1 in the formula to separate it from 

the next argument. 

3. Click in cell A3 to enter the cell into the formula. 

4. Type the closing parenthesis ), and then press ENTER. 

The result is 204904. 

5. Compare the formulas in cell A5 and in cell C2. First, click in cell A5, and then look at the formula at the top of 

the spreadsheet, in the Formula Bar. The formula looks like this: =SUM(A1:A4). 

6. Click in cell C2 (if that’s where you typed the last formula), and look at the formula in the Formula Bar. The 

formula looks like this: =SUM(A1,A3) 

In the first formula, the colon between A1 and A4 indicates that the formula argument contains all the cells 

from A1 through A4. In the second formula there is no colon because it contains two cells that are not 

next to each other. The comma between A1 and A3 separates one formula argument (A1) from the 

second argument (A3).  

EXERCISE 5: COPY A FORMULA FROM 1 CELL TO ANOTHER, USING RELATIVE CELL 

REFERENCES 

1. First, change the spreadsheet you are working on. At the bottom of the spreadsheet, click the Sales Data tab. 

2. Click in cell B7. Look in the formula bar above the spreadsheet to see the formula in the cell: =SUM(B2:B6). 

3. In cell B7, point to the lower-right corner of the cell, until the pointer changes into a black plus sign . 

4. Click and drag from cell B7 to cell C7. Release the mouse button. The result in cell C7 is $9,041.80. 

5. When the cursor still in cell C7, look at the formula in the formula bar. The new formula is =SUM(C2:C6). The 

formula value changed because the cell references are relative and automatically change to reflect the 

location of the new formula. 



EXERCISE 6: CREATE A FORMULA WITH ABSOLUTE CELL REFERENCES 

In this formula, you’ll calculate the 3% commission for each salesperson, based on the total of their sales for 

Week 1 and Week 2. 

1. First, total the sales for both weeks. Click in cell D2. On the Home tab, in the Editing group, click the 

AutoSum button. 

2. Press ENTER to get the total into the cell. Result: $1,129.20. 

3. Now copy the formula in cell D2. Click in cell D2, then point to the lower-right corner of the cell, until the 

pointer changes into a black plus sign . 

4. Click and drag from cell D2 to cell D6. Release the mouse button. The result: 

 Cell D3, $3,806.40 

 Cell D4, $2,994.60 

 Cell D5, $1,246.06 

 Cell D6, $7,973.50 

5. Click in an empty cell, for example, F2. Type 0.03. Press ENTER. 

6. Click in cell E2. Type an equal (=) sign. 

7. Click in cell D2 to enter that cell into the formula. In the formula, type an asterisk (*) to multiply the commission 

rate. 

8. Click in cell F2 to enter the commission rate into the formula. Cell F2 is entered into the formula. 

9. On your keyboard, press F4 . In the formula, F2 is converted into an absolute cell reference: $F$2. 

Press ENTER. Result: $33.88. 

10. Copy the formula. Click in cell E2, then point to the lower-right corner of the cell, until the pointer changes into 

a black plus sign . 

11. Click and drag from cell E2 to cell E6. Release the mouse button. The result: 

 Cell E3, $114.19 

 Cell E4, $89.84 

 Cell E5, $37.38 

 Cell E6, $239.21 

12. Click in cell E2 and look at the formula bar to see the formula: =D2*$F$2. Click in cell E3 and look in the 

formula bar: =D3*$F$2. The relative cell reference D2 changed to D3. The absolute cell reference $F$2 

stayed the same. 

EXERCISE 7: CREATE A FORMULA WITH MIXED CELL REFERENCES 



In this exercise, you’ll fill in a commission rate table to see commissions based on different sales levels and 

different commission rates. 

BEFORE YOU BEGIN: If you see pound signs (# # # #) in column C, it means that the column is not wide 

enough to fit the content. To make the column wider, move the cursor to the top of the column, to the right edge 

of column C. When the cursor changes into a double-headed pointer, click and drag to the right. Release the 

mouse button when the pound signs disappear.  

1. First, change the spreadsheet you are working on. At the bottom of the spreadsheet, click the Commission 

Table tab. Column C contains a list of sales by amount. Row 3 contains different commission rates. 

2. In your formula, you need to determine which column and which row should be absolute. You always want the 

formula to point to column C with the sales rates, so column C will be absolute. You also want the formula to 

point to the commission rates, so row 3 will be absolute. 

3. Click in cell D4 to create your first formula. Type an equal (=) sign. Click in cell C4 to enter the Sales amount 

into the formula. Your formula looks like this: =C4. 

4. Change “C” into an absolute reference. On your keyboard, press F4 . Result: $C$4. Press F4 again. 

Result: C$4. Press F4 once more. Result: $C4. Now you have an absolute reference to column C ($C), and a 

relative reference to row 4 (4). 

5. Your cursor is still in the formula. Type an asterisk (*) to multiply the sales amount by the commission rate. 

Now your formula looks like this: $C4*. 

6. In the formula, type D3 to enter the commission rate into the formula. The formula looks like this: $C4*D3. You 

need to make row 3 into an absolute reference.  

7. Press F4 on your keyboard. Result: $D$3. Press F4 again. Result: D$3. That’s what you want, a relative 

reference to column D, and an absolute reference to row 3.  

8. Press ENTER. Result: $1,000.  

9. Copy the formula from cell D4 to cell H4. Click in cell D4, then point to the lower-right corner of the cell, until 

the pointer changes into a black plus sign . 

10. Click and drag from cell D4 to cell H4. Release the mouse button. The results are $2,000, $3,000, $4,000, and 

$5,000. 

11. Click in cell E4 and look at the formula bar to see the formula: =$C4*E$3. The absolute reference $C means 

that the formula will always point to column C. The $3 absolute reference means that the formula will always 

point to row 3. Next, you’ll copy the formula down the rest of the table.  

12. Click in cell D4 and drag to cell H4. A black border is around the five selected cells. In cell H4, point to the 

lower-right corner of the cell, until the pointer changes into a black plus sign . Click and drag from cell H4 

to H16. Release the mouse button. The rest of the table fills in.  

13. Click in any cell and then look at the formula bar to verify that the absolute reference to column C ($C) is the 

same, and that the absolute reference to row 3 is the same ($3) in any of the results. 

EXERCISE 8: CREATE A FORMULA USING THE PMT FUNCTION 



In this exercise, use the PMT function to calculate the monthly payments on a 30-year mortgage. Even though 

you know the function name, you’ll start the exercise by looking up the function name. 

1. First, change the spreadsheet you are working on. At the bottom of the spreadsheet, click the Functions tab.  

2. Click in cell A1. 

3. On the ribbon, click the Formulas tab. In the Function Library group, click the Insert Function button 

. The Insert Function dialog box opens. 

4. In the Search for a function box, type calculate payment. Then click Go. In the Select a function list, click 

PMT if necessary to select it. Look under the list to see a description of the PMT function. Click OK. The 

Function Arguments dialog box opens.  

5. If necessary, click in the Rate box. Near the bottom of the box, you’ll see the description of the Rate argument. 

In the box, type 5%/12. You divide the rate by 12 because you are making 12 monthly payments per year.  

6. Click in the Nper box. See the argument description near the bottom of the box. In the box, type 30*12. This is 

a 30-year mortgage, with 12 payments per year.  

7. Click in the PV box, and see the argument description under the list of arguments. In the box, type 

220000.The remaining arguments, FV and Type, are not in boldface, so they are not required to complete the 

formula. Click OK.  

8. The result, formatted in red, with parentheses, is $1,181.01. That’s the monthly payment on a $220,000 

mortgage at 5% over 30 years. 

EXERCISE 9: CREATE A FORMULA USING THE PROPER FUNCTION 

In this exercise, use the PROPER function to tidy up a list of names that are formatted with improper 

capitalization. This time you’ll use Formula AutoComplete, which you can use when you know, or are pretty sure 

you know, a function name. 

1. Click in cell F2. Type an equal = sign, and then type the first letter of the function name: P. 

1. A list of functions that start with P appears. Using the scroll bar in the list, scroll down until you see PROPER. 

Click PROPER. You see a ScreenTip that describes the function. 

2. Double-click PROPER to enter it into the formula. A ScreenTip appears, showing you the function name and the 

single argument, which is text. 

3. Click in cell E2. That gets Nancy’s name into the formula (the text argument).  

4. Type a closing parenthesis ) after E2 in the formula.  

5. Press ENTER. Nancy’s name is properly capitalized, with the first letter in uppercase, and the rest of the letters in 

lowercase.  

6. Copy the formula from cell F2 to cell F10. Click in cell F2, point to the lower-right corner of the cell, until the 

pointer changes into a black plus sign . Click and drag from cell F2 to cell F10. Release the mouse button. 



All the names are properly capitalized. If you click any of the names in column F and look in the formula bar, you 

can see the formula. You don’t need to keep the formula, and you don’t need two columns.  

7. Column F should still have a black border from when you copied the formula down the column. Right-click in 

column F, and then click Copy. A marquee appears around the column.  

8. Next, click in cell E2 and drag down the column to cell E10. Column E should have a black border around it. 

Right-click, and then click Values under Paste Options.  

9. Press ESC to get rid of the marque around column F. Click in cell E2, and then look in the formula bar. You see 

Nancy’s name instead of a formula. 

10. Finally, delete column F, which has the names with formula. Click in cell F2. Drag down the column to cell F10. 

Press DELETE on your keyboard. Now you have just one column of names, properly capitalized. 

 


